This Turabian packet will help students format a Turabian paper, including the bibliography and footnotes.

These handouts conform to the current Turabian standards. However, professors may change their requirements for individual papers. One should consult with his or her professor for any special requirements.
Sample Pages

Title page for a class paper (Pg. 377)

The First Chapter of Genesis:
Creation

Ima Student
Old Testament Survey 1301
January 9, 2010

Title page for a dissertation (Pg. 378)

Dallas Baptist University

The First Chapter of Genesis:
Creation

A Dissertation Submitted to
Dr. Miller
In Partial Fulfillment of the
Requirements for the Degree of
Doctor of Philosophy

Department of Philosophy

By

Ima Student

Dallas, Texas
January 2013

Sample first page (Pg. 390)

1

Introduction
Lorem ipsum dolor sit amet, consectetur adipiscing elit. 
Aenean commodo ligula eget dolor. Aenean massa. Cum sociis 
natoque penatibus et magnis dis parturient montes, nascetur 
ridiculus mus. Donec quam felis, ultricies nec, pellentesque eu, 
pretium quis, sem. Nulla consequat massa quis enim. Donec pede 
justo, fringilla vel, aliquet nec, vulputate eget, arcu. In enim justo, 
rhoncus ut, imperdiet a, venenatis vitae, justo. Nullam dictum felis 
eu pede mollis pretium. Integer tincidunt. Cras dapibus. Vivamus 
elementum semper nisi. Aenea

Sample second page (Pg. 391-393)

2

Lorem ipsum dolor sit amet, consectetur adipiscing elit. Ligula eget 
dolor. Aenean massa. Vulputate eleifend tellus. Aenean leo ligula, 
porttitor eu, consequat vitae, eleifend ac, enim. Aliquam 
lorem ante, dapibus Aenean imperdiet: 
{Maecenas. Donec vitae sapien ut libero venenatis faucibus. 
Lorem ipsum dolor sit amet, ligula eget dolor. Aenean massa. 
Nulla consequat massa quis enim. Donec pede justo, fringilla 
vulputate. 
Lorum ipsum dolor sit amet, Lorem ipsum dolor sit amet, Lorem ipsum dolor sit amet, Lorem ipsum dolor sit amet, Premiun quis, sem. Nulla consequat massa quis enim. Imperdiet a Aenean leo 
ligula, porttitor eu, consequat vitae, eleifend ac, enim. Aliquam 
lorem ante, dapibus Aenean imperdiet:

Maecenas. Donec vitae sapien ut libero venenatis faucibus. 
Lorem ipsum dolor sit amet, ligula eget dolor. Aenean massa. 
Nulla consequat massa quis enim. Donec pede justo, fringilla 

Etiam ultricies nisi vel augue. Donec vitae sapien ut libero venenatis 
faucibus. Lorem ipsum dolor sit amet feugiat.

1Lorem Ipsum, Dolor Sit Amet (Consectetuer: Adipsicing Elit, 2008), 123.
Turabian Basics

Title Page (Pgs. 376-378 in the Turabian Manual)
On the title page for a class paper, center the title. About seven spaces down, type one’s name, the course name and number, and the date of submission. See example on page 2.

On the title page for a dissertation, type the following information centered: Dallas Baptist University, Title (in bold,) A Dissertation Submitted to (Professor’s Name) in Partial Fulfillment of the Requirements for the Degree of Doctor of (Subject), Department (ex. Department of Philosophy), by (the student’s name), location (Dallas, TX), and the date. See example on page 2. This is the standard title page in the 8th edition of the Turabian manual, and many professors still prefer this style. Students should consult with their professors for specific guidelines.

Margins (Pg. 372)
Set margins to one inch on all sides of the page. In Microsoft Word, under “Page Layout,” click on “Margins;” set the measurements to “Normal.” This should set all margins at one inch.

Pagination (Pgs. 373-374)
The 8th edition of the Turabian manual leaves it to each university to determine how to number the title page of documents; therefore, one should consult with his or her professor for pagination advice. Most professors, however, prefer that their students refrain from adding a page number to the title page of their assignments. If this is the case, one will need to start the pagination of their paper from 0. In Microsoft Word, double click on the header and check the “Different First Page” box under the “Design” tab. Then, go to the second page, double click on the header, and insert page numbers wherever the professor has requested or, if he or she has no preference, wherever one has decided to place them. After doing so, the number 2 should appear in the location that was selected. Now, right click on the page number, select “Format page numbers,” and put a 0 in the “Start at” box. Number 1 should now show on the second page, and the title page should have no page number at all. The new manual also advises that the page number can be placed either in the footer or header, depending on the professor’s preference. If the professor requests that the page numbers be found at the bottom of the page, simply follow the same directions above after double clicking at the footer.

Spacing (Pg. 373)
Double-space the body of the paper. Single-space footnotes, block quotes, and each entry on the bibliography page; however, a blank line is needed between each entry in the bibliography and in between each footnote. Leave an extra line between the word “Bibliography” and the first citation on the Bibliography page. In Microsoft Word, the button for line spacing is found under the “Home” menu, in the “Paragraph” section. Under “Line Spacing,” select “Double” and check the box for “Don’t add space between lines of the same style.

Indents (Pgs. 75, 145, 150, 156-157, 349, 373)
Tab once before all paragraphs and footnote entries. For quotes five lines or longer, single-space and indent each line as a block quote with no quotation marks. See pages 3 and 5 of the sample paper. To get a sample paper, visit the Writing Center.

Subheadings (Pgs. 391-393)
Turabian utilizes subheadings to transition and indicate different sections of the paper. These are generally centered and bold, in 12 point font. Some professors prefer these headings to be in all capital letters with no bolding. However, according to the manual, it is also acceptable to create a unique typography as long as it is used with consistency (pg. 391). Second and third-level subheads may also be used if necessary; however, in a typical class paper, one level of subheads is usually sufficient. If the natural length and format of the paragraphs leaves a subheading dangling on the end of a page, it is acceptable to insert an extra line to push that title and the accompanying information to the next page. See the UWC sample paper for examples.
Names and Titles (Pgs. 145, 149, 394)
Within the paper, the first reference to a researcher or author should include his or her entire name. In subsequent references, use only his or her last name.

Titles of longer works like books and journals should be italicized, while titles of articles and chapters should be in quotation marks.

Numbers (Pgs. 318-326)
The general rule for Turabian is to spell out numbers one through one hundred in subjects that use numbers only occasionally, such as the social sciences. Spell out round numbers followed by hundred, thousand, etc. In all other situations, use Arabic numerals.

Formatting Citations

Styles for Citing Sources in a Turabian Paper (Pgs. 27-28, 138-139)
In Turabian style, there are two citation options. The first uses footnotes or endnotes, and the other uses parenthetical references. One’s instructor will usually indicate which type of documentation to use. If the professor does not have a preference, the student may decide which method to use, and then use only that method throughout the paper. Since the majority of professors prefer footnotes or endnotes, this packet addresses this style for the sake of simplicity. If students are instructed to use parenthetical citations or if they prefer them, the Writing Center has a separate handout that addresses this alternative.

Why Cite?
If someone else’s ideas or words are used to help create ideas and reach conclusions while writing, credit must be given to the author of the source; otherwise, one is plagiarizing. Footnotes and endnotes are used to show where credit is due.

Endnotes (Pgs. 145-157)
Endnotes are formatted like footnotes, but they are placed on a separate page at the end of the paper before the bibliography page rather than at the bottom of each page. The page is titled “Notes.” The format of endnotes follows the same pattern as footnotes, so simply refer to the entries labeled “Footnote” when creating notes. Some professors want only footnotes for Turabian papers, while others allow any of the citation formats. If a student is unsure of which format to use, he or she should consult with his or her professor.

Basic Format of Footnotes (Pgs. 145-161)
Footnotes should be inserted at the bottom of the page. In Microsoft Word, go to the “References” tab, then click the “Insert Footnote” button. Word should automatically insert a line that separates the footnote from the text and a number. Tab the number over once to indent the footnote.

- The first time a source is used, all the publication information should be listed within the footnote. Each new source used within the paper will have a full-length footnote that nearly parallels the bibliography entry.
- For all subsequent references to this source, omit the publication information and just include the author’s last name, a comma, and the page number: ³Jones, 23.
- If two or more works from the same author are used in the paper, also include a shortened version of the title: ³Jones, Truth, 23.
- If two consecutive references are from the same source, use the term “Ibid.” This stands for “in the same place” (Pg. 161). See the following examples:


2. Ibid., 17.


4. Lastname, 12.

5. Ibid.

**NOTE:** When using footnotes or endnotes, most titles are capitalized using headline style. Capitalize the first word and all other words except unimportant prepositions, articles, and conjunctions. For most foreign language titles, sentence-style capitalization should be used for titles of works. Capitalize the first word and all proper nouns (Pg. 149).

**Bibliography (Pg. 399)**

If footnotes are used, there will be a page titled “Bibliography” at the end of the paper. This will include an alphabetized list of all the sources used during the writing of the paper. Leave two spaces between the title and the first entry, then single-space these entries, leaving a blank line between each entry. The first line of each entry should be aligned all the way to the left; if an entry is two lines or longer, each subsequent line should be indented. This is called a hanging indent. See the following example.

Lastname, Firstname. *The Writing Center Guide to Turabian Format: How to Write and Cite Properly.*

To format hanging indents in Microsoft Word, highlight the text, right click on it, and select “Paragraph.” Under the “Indents and Spacing” section, select “Special: Hanging.”

**Differences Between the Format of Footnotes and Bibliography Entries**

Be sure to note these few differences in citation formats:

- **Author Name:** Footnotes format the author’s name as first name last name, whereas bibliography entries format the author’s name as last name, first name.

- **Indention:** With footnotes, the first line is indented and any subsequent lines are flush to the left, whereas bibliography entries have a hanging indent (the first line is flush to the left, and subsequent lines are indented).

- **Punctuation:** Footnotes use commas and parentheses to separate elements in the entry, whereas bibliography entries use periods.

- **Page Numbers:** Footnotes include specific page numbers where the information was found, whereas bibliography entries only include page numbers if they indicate the pages of a complete article or chapter consulted.

- **Ordering:** Footnotes are numbered and ordered according to where the information is introduced in the text, whereas bibliography entries are always alphabetized and not numbered.
Printed Sources

The following are examples of citations for research from printed sources (books, magazines, newspapers, and other non-electronic sources). If online versions of printed sources have been consulted, refer to the “Internet Sources” section.

Each entry should include all of the following information that is available about the source (Pg. 137):
- Author’s name
- Book title
- Article or chapter title
- Page numbers for articles/chapters
- Journal or magazine title
- Volume, issue, edition, etc.
- Place of publication
- Publishing company
- Copyright date
- Editor, translator, etc.

Book with One Author (Pg. 146, 159)

   Footnote
1James Daniels, Postmodernism and Scripture: Cultural Analysis and Repercussions (Ennis, TX: Dallas Baptist University Press, 2006), 78-81.

   Bibliography

It is not necessary to include the state or country for well-known locations like New York, Oxford, or Chicago. For less well-known cities, include the state.

Book with Two Authors (Pg. 146, 159)

   Footnote
1Roman Jakobson and Linda R. Waugh, The Sound Shape of Language (Bloomington, IN: Indiana University Press, 1979), 78.

   Bibliography

Book with Three Authors (Pg. 146-147, 159)

   Footnote

   Bibliography
Book with More Than Four Authors (Pg. 146)

- **Footnote**
  1Harry Potter et al., *Hysteria Beyond Freud* (Berkeley: University of California Press, 1993), 110.

- **Bibliography**

Book with an Author and Editor (Pg. 147)

- **Footnote**

- **Bibliography**

Editor or Translator as “Author” (Pg. 167-168)

- **Footnote**

- **Bibliography**

A Book with No Author or Editor (Pgs. 168-169)

- **Footnote**

- **Bibliography**

Two or More Books by the Same Author (Pg. 152)

- **Footnote**

- **Bibliography**


*For the underlined space, type the underscore 3 times before the period.*
Footnote

Bibliography

Footnote

Note: s.v. represents “sub verbo” or “under the word.”

Bibliography
No bibliography entry is needed for well-known reference books.

Footnote

Bibliography
No bibliography entry is needed for well-known reference books.

Footnote


Bibliography


Footnote

Bibliography
Magazine Article (Pg. 185-186)

Footnote

Bibliography

Interviews and Personal Communications (Pg. 194)

Footnote
1 Arthur Jones, interview by Ima Student, Dallas, January 21, 2008.

Bibliography
No bibliography entry is needed for interviews.

Internet Sources

For the most part, the same important information for a printed source must be recorded for electronically accessed sources. However, there are a few extra things that are very important to include. For example, because the Internet is constantly changing, it is essential to record the date the information was accessed.

When citing a document from the World Wide Web, include as much of the following information as possible. Some sources will not provide all of the information, so it is acceptable to omit missing details. If the material being cited does not have an author, for example, simply begin with the title of the document.

- Author’s name
- Title of document in quotation marks
- Title of website from which the document was retrieved, in italics
- Any other pertinent data about the source or contributors (journal title, volume, issue, editor, etc.)
- Date of access
- URL

General Internet Format (Pg. 197)

Footnote
1 Firstname Lastname, “Title of Article or Document,” *Title of Complete Work or Website* Volume Number, Issue Number (Date of Publication): page numbers, accessed Month day, year, www.url.com.

Bibliography

Electronic Journal Article (Pg. 148)

Footnote

Bibliography
Article Obtained Through Electronic Database in DBU Library (Pg. 185, 193-194)

- **Footnote**

- **Bibliography**

Social Networking

- **Footnote**

- **Bibliography**
  No bibliography entry is needed for social networking services.

Using the Bible as a Source

When using most biblical commentaries, follow the example for “A Multivolume Work.”

When referring to whole chapters or books (Pg. 339-349)
Spell the complete name. Books and versions of the Bible are not underlined, italicized, or in quotations.

*Ex:* The New Testament was written after Christ resurrected from the dead.
*Ex:* This passage is taken from the New American Standard Bible.
*Ex:* The book of Hebrews has an anonymous author.
*Ex:* Proverbs 31 may be one of the most beautiful chapters in the Bible.

When citing by verse

- Use abbreviations both in text and in notes.
- List the chapter and verse, separated by a colon (pg. 339). Always be consistent. Spell out the version the first time, and then use abbreviations in all subsequent references.
- If the reference is given in the sentence, no footnote is necessary unless the version needs to be specified.

*Ex:* ¹Gen. 1:1 (New American Standard Version)
²Rev. 1.1 (NASB)
*Ex.* Genesis 1:1 says, “In the beginning God created the heavens and the earth.”

Punctuation (Pg. 340)
Commas are used to indicate that only the listed numbers are being cited. A hyphen is used to indicate inclusive numbers.

*Ex:* Col. 3:16, 23 (only verses 16 and 23 are being cited)
Col. 3:16-23 (every verse from 16 to 23 is being cited)
Bibliography List and Notes (Pg. 189)
Biblical citations omit all facts of publication, including place (city), publishing agency, and date.

- **Footnote**
  62 Cor. 5:13 (King James Version).

- **Bibliography**
  Usually the Bible is not included on the bibliography page, but it is acceptable to add it.

*After spelling out the version once, abbreviate it in all subsequent footnotes.

Citing a Study Bible (Pg. 173)
If citing the notes from a study Bible, one should cite it like an ordinary book with an editor as author.

- **Footnote**

- **Bibliography**

Abbreviations (Pg. 341-343)

Old Testament

<table>
<thead>
<tr>
<th>Gen.</th>
<th>Genesis</th>
<th>1 Kings</th>
<th>1 Kings</th>
<th>Eccles.</th>
<th>Ecclesiastes</th>
<th>Obad.</th>
<th>Obadiah</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lev.</td>
<td>Leviticus</td>
<td>1 Chron.</td>
<td>1 Chronicles</td>
<td>Isa.</td>
<td>Isaiah</td>
<td>Mic.</td>
<td>Micah</td>
</tr>
<tr>
<td>Deut.</td>
<td>Deuteronomy</td>
<td>Ezra</td>
<td>Ezra</td>
<td>Lam.</td>
<td>Lamentations</td>
<td>Hab.</td>
<td>Habakkuk</td>
</tr>
<tr>
<td>Ruth</td>
<td>Ruth</td>
<td>Job</td>
<td>Job</td>
<td>Hosea</td>
<td>Hosea</td>
<td>Zech.</td>
<td>Zechariah</td>
</tr>
<tr>
<td>1 Sam.</td>
<td>1 Samuel</td>
<td>Ps.</td>
<td>Psalms</td>
<td>Joel</td>
<td>Joel</td>
<td>Mal.</td>
<td>Malachi</td>
</tr>
<tr>
<td>2 Sam.</td>
<td>2 Samuel</td>
<td>Prov.</td>
<td>Proverbs</td>
<td>Amos</td>
<td>Amos</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

New Testament

<table>
<thead>
<tr>
<th>Matt.</th>
<th>Matthew</th>
<th>2 Cor.</th>
<th>2 Corinthians</th>
<th>1 Tim.</th>
<th>1 Timothy</th>
<th>2 Pet.</th>
<th>2 Peter</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mark</td>
<td>Mark</td>
<td>Gal.</td>
<td>Galatians</td>
<td>2 Tim.</td>
<td>2 Timothy</td>
<td>1 John</td>
<td>1 John</td>
</tr>
<tr>
<td>John</td>
<td>John</td>
<td>Phil.</td>
<td>Philippians</td>
<td>Philem.</td>
<td>Philemon</td>
<td>3 John</td>
<td>3 John</td>
</tr>
<tr>
<td>Rom.</td>
<td>Romans</td>
<td>1 Thess.</td>
<td>1 Thessalonians</td>
<td>James</td>
<td>James</td>
<td>Rev.</td>
<td>Revelation</td>
</tr>
<tr>
<td>1 Cor.</td>
<td>1 Corinthians</td>
<td>2 Thess.</td>
<td>2 Thessalonians</td>
<td>1 Pet.</td>
<td>1 Peter</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>


Original material copyright © Dallas Baptist University. All rights reserved. Other copyrighted material included by permission or authorization. Created by UWC Staff for Dallas Baptist University. [http://www.dbu.edu/uwc](http://www.dbu.edu/uwc). August 2015.